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Abstract

Kugar is a template based XML report engine. Kugar Report Designer is a
flexible GUI report template designer for Kugar report engine.
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Chapter 1

Introduction

Kugar is a report creation tool for QtTM and KDE. It includes a GUI report
template designer, a report engine, a Konqueror part for easy report preview
and a set of examples.

The Kugar Report Designer is a report template creation tool for the Kugar
report engine. The Kugar report engine uses an XML based report template
file (which can be created by hand or with Kugar Report Designer) and a data
file (also in XML format) to create reports. To get more information on Kugar
Report Designer refer to the Report Template Designer Manual.

See The KugarTemplate Document Type Definition for an overview of the tem-
plate’s DTD (file format), KugarData Document Type Definition and Tutorial
for a step-by-step explanation on how reports can be created.

Programmers should also refer to the Programmer’s guide to find information
about using Kugar in their own applications.
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Chapter 2

Tutorial

Alexander Dymo and Phil Thompson This tutorial attempts to be a brief intro-
duction to Kugar.

You will create a sample report template with Kugar Report Designer, a sample
data file and finally generate a complete report.

The source code for sample templates and data files can be found in sample1-
.ktf and sample1.kdf that are distributed with Kugar.

2.1 Creating the report template with Kugar Report
Designer

Run Kugar Designer by typing kudesigner in the shell.

After you start the designer, choose File|New and set the page size to Letter
and paper orientation to Landscape. Set the left and right margins to 48, top
and bottom margins to 40. All dimensions in Kugar Report Designer (page
margins, sizes, positions, etc.) are measured in millimeters.
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A new report is now created and all buttons on the Items Toolbar and Sec-
tions Toolbar are now enabled (the corresponding menu items from Items and
Sections are also enabled).

Now it is the time to add some sections to the report and determine their sizes.
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We will add report header and footer, page header and footer and a single
detail section. Report headers and footers are printed on the first page and on
the last page of the report before and after any other report data accordingly.
Report footers are good places for calculated fields. Page headers and footers
are printed at the top and bottom of each page. Our report will have one detail
section with level 0. This means that all our data rows have identical structure
(i.e. fields). If the data structure is more complex or it is organized according
to a master-detail relationship, more detail levels should be created. See samp-
le3.ktf and sample3.kdf for an example of how that can be done. Refer to the
template elements descriptions for additional information.

Sections are added by using Sections menu or a Sections Toolbar. Now add a
report header and footer, a page header and footer and then a detail section.
When adding a detail section, set its level to 0 as shown on the screenshot
below.

Our report should now look like this one in the screenshot.

All our sections have a predefined height - 50mm. Let’s change it. To do this
right mouse button click on the Report Header section or click the Edit Prop-
erties button on the Edit Toolbar and then choose a section. The Properties
window should be shown.
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Now set the Report Header’s height to 70. Let’s perform that procedure for all
other sections. Set the Page Header’s height to 45 and the Detail’s to 30. The
Page and Report Footers should be 32 mm in height.

A report template with properly sized sections is ready to be filled with report
items.
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You can now add items to the sections on the report. Five different types of
items can be added to the report. Label is a rectangular area that can have
borders and can be filled by any kind of textual data. The Label’s foreground
and background colors, as well as fonts, can be changed. Border line types and
line colors are also customizable. Fields can be placed on to a detail section.
Fields represent data fields; their values will be collected from a data file while
generating a report. Counts, sums, averages, etc. for field values can be printed
on the report by means of Calculated Fields. Specials are labels with predefined
text, such as current date or page number. The general report appearance can
be refined with Lines.
To add a report item click the corresponding item button on the Items Toolbar
and place (click) it on the section. The chosen item will be placed on the se-
lected section with the upper left corner at the given coordinates. Other proper-
ties are set to default values and can be changed with the Report Item Options
dialog (the same way we used to change the section’s height).

So, let’s add labels to the report header and page header as shown on the
screenshot below. Note that the ‘Mutiny Bay Software’ label has its Border-
Style and BorderWidth set to 0 and ‘Software Inventory Report’ - 1mm. Any
colors are set as a combination of three values (RGB - red,green,blue) separated
by commas.

We will also add field elements to the detail section. Just assume we have four
fields - title, version, platform and copies. So, four Field elements should be
placed and their Field properties set. Note that Text property is automatically
set to ‘[field_name]’.

Our page footer is a good place to show the current date and page number,
so add two special fields and set their Type properties to 0 and 1. A special
with Type=0 will represent date and one with Type=1 - page number. Note
that special’s Text property is changed automatically.

The last element to be placed is a Calculated Field for the ‘copies’ field. To

6



The Kugar Handbook

acquire a sum (copies) set the calculated field’s Field property to ‘copies’ and
CalculationType to 1 (sum function).

Finally, our report template should look like this:

2.2 Creating the report data file

Generally speaking, data files may be created in several ways. Some will use
xsl transformation tables to generate proper XML from another XML document
(like a KSpread spreadsheet); others will use their own program to fetch data
from a database and fill the data file. In this tutorial we will simply create it
by hand. The source code for the example can be found in file sample1.kdf or
copied from the example below.

<?xml version=1.0 encoding=UTF -8?>

<!DOCTYPE KugarData [
<!ELEMENT KugarData (Row* )>
<!ATTLIST KugarData

Template CDATA #REQUIRED >

<!ELEMENT Row EMPTY >
<!ATTLIST Row

level CDATA #REQUIRED
title CDATA #REQUIRED
version CDATA #REQUIRED
platform CDATA #REQUIRED
copies CDATA #REQUIRED >

]>
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<KugarData Template="sample1.ktf">
<Row level="0" title=" BRU" version ="15.0" platform="x86 ←↩

" copies="1"/>
<Row level="0" title=" Caldera Open Linux" version ="2.2" ←↩

platform="x86" copies="3"/>
<Row level="0" title=" K Desktop" version ="1.1.1" ←↩

platform="x86" copies="1"/>
<Row level="0" title=" Netscape Communicator" version ←↩

="4.6" platform="x86" copies="10"/>
<Row level="0" title=" Redhat Linux" version ="5.0" ←↩

platform="x86" copies="11"/>
<Row level="0" title=" Redhat Linux" version ="5.1" ←↩

platform="x86" copies="12"/>
<Row level="0" title=" Redhat Linux" version ="5.2" ←↩

platform="x86" copies="14"/>
<Row level="0" title=" Redhat Linux" version ="6.0" ←↩

platform="x86" copies="15"/>
<Row level="0" title=" Star Office" version ="5.0" ←↩

platform="x86" copies="1"/>
<Row level="0" title=" Star Office" version ="5.1" ←↩

platform="x86" copies="3"/>
<Row level="0" title=" Microsoft Windows NT" version ←↩

="3.1" platform="x86" copies="1"/>
<Row level="0" title=" Microsoft Windows NT" version ←↩

="3.51" platform="x86" copies="1"/>
<Row level="0" title=" Microsoft Windows NT" version ←↩

="4.0" platform="x86" copies="1"/>
<Row level="0" title=" Microsoft Windows NT" version ←↩

="5.0" platform="x86" copies="1"/>
<Row level="0" title=" Sun Solaris" version ="2.5" ←↩

platform="Sparc" copies="1"/>
</KugarData >

2.3 Generating the report

At this moment we have a report template (sample1.ktf) and a report data file
(sample1.kdf).

To generate a report, type the following command in the shell: kugar -r sam-
ple1.ktf -d sample1.kdf

This will bring up a Kugar shell window with the report generated.
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Chapter 3

Starting Kugar and Kugar
Report Designer

Alexander Dymo and Phil Thompson The Kugar program takes two comman-
dline arguments:

kugar [-d Kugar data file] [-r Kugar template file]

For example, kugar -d sample1.kdf -r sample1.ktf

The Kugar Report Designer program can be started with no arguments or with
a report template file name as an argument:

kudesigner [template.ktf]
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Chapter 4

Report Template Designer
Manual

Alexander Dymo and Phil Thompson Kugar Report Designer allows interac-
tive creation and modification of report templates, and placement of report
sections and section items onto a report.

Kugar Report Designer is a WYSIWYG application. Report page size defines
the report dimensions on the screen. At the present moment, the scale is set to
100% automatically and cannot be changed.

EVERY REPORT TEMPLATE MAY CONTAIN THE FOLLOWING REPORT SECTIONS:

• Report Header

• Page Header

• Detail Header

• Detail

• Detail Footer

• Page Footer

• Report Footer

REPORT SECTIONS MAY CONTAIN THE FOLLOWING REPORT ITEMS:

• Label

• Field

• Calculated Field

• Special Field

• Line

11



The Kugar Handbook

Report sections and items can be placed onto the report template by using
menus or toolbars.
Every element, such as a report template, a report section or an item has its
own properties. These properties define geometrical, textual and any other pa-
rameters. Every time an element is placed, a set of default properties is applied.
For example, when Label is placed, its Text property value is set to ‘Text’.

To change properties, use the Report Item Options dialog. This dialog can be
called by right mouse button clicking on an item or with an Edit Properties
button in the Edit Toolbar. See screenshot below (properties for a Field item):

To delete an item, middle mouse button click on it or use the Delete button in
the Edit Toolbar.
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THE KUGAR REPORT DESIGNER MENU REFERENCE

File→New (Ctrl+N) Bring up the New Report dialog to create a new report
template.
As seen on the screenshot, the report page size, orientation and margins
must be set before the report can be created.

File→Open... (Ctrl+O) Open the previously saved report template.

File→Open Recent Display a list of recently opened templates. Select a file
to open it.

File→ Save (Ctrl+S) Save the current report template into a text file in XML
format.

File→ Save As... Save the current report template into a file and give it an-
other name.

File→ Close (Ctrl+W) Close the current report template.

File→ Print (Ctrl+P) Print... the current report template as text in XML for-
mat.

File→Quit (Ctrl+Q) Quit the program.
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Edit→ Clear Selection Cancel any edit action, so no properties will be edited
or items deleted.

Edit→ Edit Properties Edit properties of the selected item.

Edit→Delete Delete the selected item.

Sections→ Report Header Place the Report Header section onto the report
template.

Sections→ Page Header Place the Page Header section onto the report tem-
plate.

Sections→Detail Header Place the Detail Header section onto the report tem-
plate.
Before placing the section, the Add Detail Header dialog will be shown
to specify the detail level. The Detail header will be added to the detail
section of the given level.

Sections→Detail Place the Detail section onto the report template.
Before placing the section, the Add Detail dialog will be shown to specify
the detail level.

Sections→Detail Footer Place the Detail Footer section onto the report tem-
plate.
Before placing the section, the Add Detail Footer dialog will be shown
to specify the detail level. The Detail footer will be added to the detail
section of the given level.
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Sections→ Page Footer Place the Page Footer section onto the report template.

Sections→ Report Footer Place the Report Footer section onto the report tem-
plate.

Items→ Clear Selection Clear item selection, so no report item will be added
to the section.

Items→ Label Place the Label element onto the section.

Items→ Field Place the Field element onto the section.

Items→ Calculated Field Place the Calculated Field element onto the section.

Items→ Special Field Place the Special Field element onto the section.

Items→ Line Place the Line element onto the section.
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Chapter 5

Programmer’s Guide

Alexander Dymo and Phil Thompson

5.1 How to use Kugar for reporting in your own pro-
grams

THERE ARE SEVERAL WAYS TO USE KUGAR

• Create a temporary file and fill it with data, organized according to the Ku-
garData Document Type Definition. Then call the kugar shell command (
kugar [-d Kugar data file] [-r Kugar template file] ) to preview and
print the report. See Using Kugar shell for previewing reports for a detailed
description.

• Use Kugar directly in the application’s code. See Using Kugar classes for
reporting for a detailed description.

• Create a QtTM designer plugin, use it to build the application GUI in the
designer and link it to the program dynamically. See Creating a Qt designer
plugin for a detailed description.

The last two ways are acceptable for QtTM and KDE developers; but Kugar is
designed to be a report generator, independent from a programming language
and/or IDE. It uses XML format for describing report templates and data files.
So any program can produce output in Kugar data file format as described
in KugarData DTD or even a report template file format (see KugarTemplate
DTD). Kugar shell (report viewer) can be used to preview and print the gener-
ated report.
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5.2 Using Kugar shell for previewing reports

THE WAY TO CREATE AND PREVIEW (PRINT) A REPORT IS:

1. Create a report template file with Kugar Report Designer

2. Create a data file with column values for detail bands of the report. Use
KugarData DTD to produce correct data files.

3. Run Kugar shell to preview and print a report. For example, to do this,
in C or C++ languages call:

system("kugar -r template_file.ktf -d data_file.kdf").

Don’t forget to include stdlib.h.

5.3 Using Kugar classes for reporting

The Kugar library includes two widgets for use.

The KReportViewer class is designed for KDE developers. It supports a KDE
printing system and UNIX R© localization via i18n() calls.

The MReportViewer class is designed for QtTM developers and provides real
crossplatforming. It can be used not only on UNIX R© platforms, but also on
Windows R© and Mac R© OS.

In order to build a program that uses the Kugar library, it should be linked with
libkugar.so shared library, which is provided with the Kugar distribution on
all UNIX R© platforms.

Include files are kugarqt.h and kugar.h for QtTM and KDE programs respec-
tively.

For a detailed example of how Kugar classes can be used, look in the /shell
folder in the Kugar sources.

MReportViewer (and KReportViewer too) contains several public methods that
can be used.
void renderReport(void);

Renders the report onto a screen.

void printReport(void);

Calls the print dialog to print the report.

void clearReport(void);
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Clears the report on a screen and frees report data.
Call this before opening the new report.

bool setReportData(const QString &data_file_name);

Sets report data from data_file_name file.

bool setReportData(const QIODevice &data_io_device);

Sets report data from data_io_device file.
IO device can be any successor of the QIODevice class.
For example, to fetch records directly from the database,
create a QIODevice successor and redefine all necessary
functionality.

bool setReportTemplate(const QString &template_file_name);

Sets report template from template_file_name file.

bool setReportTemplate(const QIODevice &template_io_device);

Sets report template from template_io_device file.
IO device can be any successor of the QIODevice class.
For example, to obtain a report template from network storage or database,
create a QIODevice successor and redefine all necessary functionality.

5.4 Creating QtTM designer plugin

This is the example code of how a designer plugin is created. The code below
creates a plugin for a KDE KReportViewer widget.

If a QtTM widget is desired, replace KReportViewer with MReportViewer and
kugar.h with kugarqt.h in the plugin code.

5.4.1 Plugin usage

The designer plugin will allow the usage of QtTM Designer to place a KRepor-
tViewer widget onto a window and preview it correctly.

Programs that make use of this plugin must be linked dynamically with it.
The corresponding library is called libkugar_plugin.so. Widgets or dialogs
that include KReportViewer widget must include <kugar.h> in implementation
and have a forward declaration of class KReportViewer. Includes can be done
with QtTM Designer’s Object Explorer (Source tab).

To build the plugin run:

qmake [kugar_plugin.pro]
make

18



The Kugar Handbook

5.4.2 Plugin code

The plugin code consists of three files:
kugar_plugin.h: A header file for the KugarWidgetPlugin, QWidgetPlugin suc-
cessor;, kugar_plugin.cpp: A source file for the KugarWidgetPlugin, QWidgetPl-
ugin successor;, kugar_plugin.pro: A project file for the QMake utility.

5.4.2.1 kugar_plugin.h

#include <qwidgetplugin.h>

class KugarWidgetPlugin:public QWidgetPlugin
{
public:

KugarWidgetPlugin ();

QStringList keys () const;
QWidget *create (const QString & classname , QWidget * ←↩

parent =
0, const char *name = 0);

QString group (const QString &) const;
QIconSet iconSet (const QString &) const;
QString includeFile (const QString &) const;
QString toolTip (const QString &) const;
QString whatsThis (const QString &) const;
bool isContainer (const QString &) const;

};

5.4.2.2 kugar_plugin.cpp

#include "kugar_plugin.h"
#include <kugar.h>

static const char *kugar_pixmap[] = {
"22 22 127 2",
".d c #000000",
".c c #131313",
".b c #282828",
".a c #434241",
".e c #4e463a",
".# c #595551",
".G c #66553b",
"#F c #68635f",
"#R c #6b4f23",
"#q c #6e6862",
"#M c #6f5229",
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".n c #6f6146",
".w c #735310",
".V c #755c2a",
".I c #775f34",
".0 c #77694a",
"#n c #7e6434",
".o c #806f50",
"#C c #835d2d",
".P c #837c75",
"#B c #85653a",
"#k c #85827e",
".x c #866d46",
".U c #877967",
".X c #888888",
".F c #89724d",
"#x c #8b6d2a",
".S c #8d7759",
".z c #8e733b",
"#L c #906e49",
"#Q c #947b56",
".r c #948058",
".J c #957844",
".4 c #987736",
".q c #998969",
".k c #999897",
".R c #9a8a75",
"#i c #9f8348",
"#I c #a37c4b",
".u c #a38d66",
".E c #a58558",
"#A c #a8834b",
".s c #a9967a",
".t c #aa9467",
".C c #ae9f8d",
"#6 c #afa49d",
"#5 c #afa9a4",
"#W c #b18e4d",
".K c #b1935a",
".B c #b39660",
"#V c #b49866",
"#a c #b49d6c",
"## c #b49d72",
".j c #b5b4b4",
"#0 c #b7a597",
".O c #b9b1a9",
".L c #bb9c61",
".M c #bb9e6b",
".A c #bca778",
"#j c #bea46b",
".T c #bfb37d",
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".v c #c0b391",
".W c #c3a262",
".i c #c4c4c4",
"#m c #c5b7aa",
"#8 c #c69f80",
".D c #c6b79b",
"#3 c #c7a589",
".7 c #c7a76c",
"#u c #c7bbaf",
".6 c #c8ad74",
"#7 c #c8b7a9",
"#r c #c8beb5",
".m c #c8c8c8",
"#U c #cbad96",
"#f c #ccb681",
"#h c #cdac6c",
"#P c #cdb49f",
"#X c #cdb8a6",
"#H c #ceb7a4",
".y c #ceb892",
".N c #cecac3",
"#Z c #cfb16f",
"#O c #cfbdad",
".Z c #cfc7c0",
"#w c #d0bcab",
".5 c #d1ad6b",
"#s c #d1bfb1",
".h c #d5d5d5",
"#l c #d6cdc6",
"#D c #d8b36e",
".H c #dac592",
"#t c #dbb977",
".g c #dcdcdc",
".1 c #e0dcc1",
".f c #e0e0df",
"#1 c #e3c8b1",
"#S c #e4cdb9",
".3 c #e4d9a3",
"#4 c #e6c1a1",
"#2 c #e7c4a5",
"#K c #e9c179",
"#g c #e9c47e",
"#Y c #e9c8ac",
".2 c #eae6c0",
"#T c #ebcdb3",
".Q c #ebd4b9",
"#E c #ecca87",
"#z c #ecd799",
".l c #ececeb",
"#G c #efd7c2",
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"#e c #efe3ab",
".8 c #efe8e3",
"#v c #f1dcca",
"#. c #f2e2d4",
".p c #f4f4f4",
"#y c #f5daa0",
"#J c #f6cf7f",
".9 c #f7ede4",
"#p c #f9d995",
".Y c #fcf9f6",
"#d c #fefcc5",
"#c c #fefdda",
"#b c #fefee1",
"#N c #ffd685",
"#o c #fff0a9",
"Qt c #ffffff",
"QtQtQtQtQtQt.#.a.a.a.b.b.b.c.c.d.d.dQtQtQtQt",
"QtQtQtQtQtQt.e.f.g.g.f.g.g.h.i.j.d.k.dQtQtQt",
"QtQtQtQtQtQt.a.gQtQtQtQtQtQt.l.f.c.m.k.dQtQt",
"QtQtQtQtQt.n.n.n.n.n.o.g.pQtQt.l.bQt.m.k.dQt",
"QtQtQt.q.q.r.q.s.t.r.q.u.u.g.pQt.a.fQt.m.k.d",
"QtQt.s.s.v.w.x.y.y.t.z.A.t.B.i.p.#.a.b.c.d.d",
"Qt.C.C.D.E.F.G.A.H.F.I.J.K.L.M.i.p.l.N.O.P.d",
"Qt.s.v.Q.q.R.S.T.A.R.U.V.L.W.W.X.g.Y.f.Z.k.d",
".0.s.t.Q.1.U.R.2.3.S.U.4.5.6.6.7.j.8.9#..O.d",
".G##.V#a#b.1#c#c#d#e#f#g#h#i#j.W#k#l.9#.#m.d",
".G.4.F#n#c#c#c#d#d#o#p#g.x.w#i.L#q#r#.#.#s.d",
".e.J.J.I.3#d.H#j.6#f#p#t#n.w.E.L#q#u#.#v#w.d",
".G.A#x.z#y#z#A#B#B#C#D#E.4.4.6#h#F#m#v#G#H.d",
".o.s.A#j#E#t#I#I#I#C#A#J#p#p#K#t#F#m#v#G#H.d",
"Qt##.A.6.7#I#I#A.E#L#M.W#N#J#K.a.U#O#G.Q#P.d",
"Qt#a.M.L.J#A#I.4.E#Q.x#R#D#J#g.#.C#S.Q#T#U.d",
"QtQt#V.K.z#Q.s.S.x.S#B#M#W#E.a.U#X.Q#T#Y#U.d",
"QtQtQt.M#i#B.r#Q#Q.r#Q.z#Z.a#q#0#1#T#Y#2#3.d",
"QtQtQtQtQt#j.L.L.W.5#t.a.#.U#0#1#T#Y#2#4#3.d",
"QtQtQtQtQtQt.d#F#q#q#q.P.C#O#S.Q#T#Y#2#4#3.d",
"QtQtQtQtQtQt.d#5#5#6#6#0#7#w#H#P#U#U#3#3#8.d",
"QtQtQtQtQtQt.d.d.d.d.d.d.d.d.d.d.d.d.d.d.d.d"

};

KugarWidgetPlugin::KugarWidgetPlugin ()
{
}

QStringList KugarWidgetPlugin::keys () const
{

QStringList list;
list << "KReportViewer";
return list;

}
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QWidget* KugarWidgetPlugin::create (const QString & key , ←↩
QWidget * parent ,

const char *name)
{

if (key == "KReportViewer")
return new KReportViewer (parent , name);

return 0;
}

QString KugarWidgetPlugin::group (const QString & feature) ←↩
const

{
if (feature == "KReportViewer")

return "Display";
return QString::null;

}

QIconSet KugarWidgetPlugin::iconSet (const QString &) const
{

return QIconSet (QPixmap (kugar_pixmap));
}

QString KugarWidgetPlugin::includeFile (const QString & ←↩
feature) const

{
if (feature == "KReportViewer")

return "kugar.h";
return QString::null;

}

QString KugarWidgetPlugin::toolTip (const QString & feature) ←↩
const

{
if (feature == "KReportViewer")

return "Kugar report viewer widget";
return QString::null;

}

QString KugarWidgetPlugin::whatsThis (const QString & feature ←↩
) const

{
if (feature == "KReportViewer")

return "A widget to view xml reports";
return QString::null;

}

bool KugarWidgetPlugin::isContainer (const QString &) const
{

return FALSE;
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}

Q_EXPORT_PLUGIN( KugarWidgetPlugin )

5.4.2.3 kugar_plugin.pro

SOURCES += kugar_plugin.cpp
HEADERS += kugar_plugin.h

DESTDIR = $(QTDIR)/plugins/designer
TARGET = kugar_plugin

target.path=$$plugins.path
isEmpty(target.path):target.path=$$QT_PREFIX/plugins
PROJECTNAME = KugarPlugin
TEMPLATE = lib
CONFIG += qt warn_on release plugin
unix:LIBS += -lkugar
LANGUAGE = C++
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Chapter 6

Credits and License

Kugar

Copyright 2000 Mutiny Bay Software

Copyright 2000, 2001, Phil Thompson

Copyright 2002 Alexander Dymo

Portions of the documentation Copyright 2000, 2001 Phil Thompson and Copy-
right 2002 Alexander Dymo

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.
This program is licensed under the terms of the GNU General Public License.
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Appendix A

Document Structure

A.1 The KugarTemplate Document Type Definition

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE KugarTemplate [

<!ELEMENT KugarTemplate (ReportHeader, PageHeader, DetailHeader*, Detail*, DetailFooter*, PageFooter, ReportFooter)>
<!ATTLIST KugarTemplate

PageSize CDATA #REQUIRED
PageOrientation CDATA #REQUIRED
TopMargin CDATA #REQUIRED
BottomMargin CDATA #REQUIRED
LeftMargin CDATA #REQUIRED
RightMargin CDATA #REQUIRED>

<!ELEMENT ReportHeader (Line*, Label*, Special*)>
<!ATTLIST ReportHeader

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT PageHeader (Line*, Label*, Special*)>
<!ATTLIST PageHeader

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT DetailHeader (Line*, Label*, Special*)>
<!ATTLIST DetailHeader

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

<!ELEMENT Detail (Line*, Label*, Special*, Field*)>
<!ATTLIST Detail

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

<!ELEMENT DetailFooter (Line*, Label*, Special*)>
<!ATTLIST DetailFooter

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

<!ELEMENT PageFooter (Line*, Label*, Special*)>
<!ATTLIST PageFooter

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT ReportFooter (Line*, Label*, Special*, CalculatedField*)>
<!ATTLIST ReportFooter
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Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT Line EMPTY>
<!ATTLIST Line

X1 CDATA #REQUIRED
Y1 CDATA #REQUIRED
X2 CDATA #REQUIRED
Y2 CDATA #REQUIRED
Width CDATA #REQUIRED
Color CDATA #REQUIRED
Style CDATA #REQUIRED>

<!ELEMENT Label EMPTY>
<!ATTLIST Label

Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED>

<!ELEMENT Field EMPTY>
<!ATTLIST Field

Field CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DataType CDATA #REQUIRED
DateFormat CDATA #REQUIRED
Precision CDATA #REQUIRED
Currency CDATA #REQUIRED
NegValueColor CDATA #REQUIRED
CommaSeparator CDATA #REQUIRED>

<!ELEMENT CalculatedField EMPTY>
<!ATTLIST CalculatedField

CalculationType CDATA #REQUIRED
Field CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
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Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DataType CDATA #REQUIRED
DateFormat CDATA #REQUIRED
Precision CDATA #REQUIRED
Currency CDATA #REQUIRED
NegValueColor CDATA #REQUIRED
CommaSeparator CDATA #REQUIRED>

<!ELEMENT Special EMPTY>
<!ATTLIST Special

Type CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DateFormat CDATA #REQUIRED>

]>

A.2 KugarTemplate element

The KugarTemplate element defines report attributes relating to page size, ori-
entation, and margins.

<!ELEMENT KugarTemplate (ReportHeader, PageHeader, DetailHeader*, Detail*, DetailFooter*, PageFooter, ReportFooter)>
<!ATTLIST KugarTemplate
PageSize CDATA #REQUIRED
PageOrientation CDATA #REQUIRED
TopMargin CDATA #REQUIRED
BottomMargin CDATA #REQUIRED
LeftMargin CDATA #REQUIRED
RightMargin CDATA #REQUIRED>
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Elements The KugarTemplate element contains the following elements:

ReportHeader The ReportHeader element defines report sections that
are usually printed at the beginning of the report.

PageHeader The PageHeader element defines report sections that are usu-
ally printed at the top of every page of the report.

DetailHeader The DetailHeader element defines report sections that are
printed before details of a given level on the report.

Detail The Detail element defines the report section that contains the
report data. The report can have an unlimited number of details.

DetailFooter The DetailFooter element defines report sections that are
printed after details of a given level and below on the report.

PageFooter The PageFooter element defines report sections that are usu-
ally printed at the end of every page in the report.

ReportFooter The ReportFooter element defines report sections that are
usually printed at the end of the report.

Attributes

PageSize Sets the size of the report page. The following values are avail-
able:

Value Page Size
0 A4
1 B5
2 Letter
3 Legal
4 Executive
5 A0
6 A1
7 A2
8 A3
9 A5
10 A6
11 A7
12 A8
13 A9
14 B0
15 B1
16 B10
17 B2
18 B3
19 B4
20 B6
21 B7
22 B8
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23 B9
24 C5E
25 Comm10E
26 DLE
27 Folio
28 Ledger
29 Tabloid
30 NPageSize

PageOrientation Sets the report page orientation.

Value Orientation
0 Portrait
1 Landscape

TopMargin Sets the top margin of the report page.
BottomMargin Sets the bottom margin of the report page.
LeftMargin Sets the left margin of the report page.
RightMargin Sets the right margin of the report page.

A.3 KugarTemplate template elements

Section bands Section elements
ReportHeader Line
PageHeader Label
DetailHeader Field
Detail CalculatedField
DetailFooter Special
PageFooter Page Footer
ReportFooter Report Footer

A.3.1 ReportHeader and ReportFooter sections

The ReportHeader and ReportFooter elements define report sections that are
usually printed at the beginning and end of the report.

<!ELEMENT ReportHeader (Line*, Label*, Special*)>
<!ATTLIST ReportHeader
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Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT ReportFooter (Line*, Label*, Special*, CalculatedField*)>
<!ATTLIST ReportFooter

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

Attributes

Height Sets the height of the report section. If you don’t want this sec-
tion, set this value to 0.

PrintFrequency Set the print frequency of the section.

Value Print Frequency
0 First Page
1 Every Page
2 Last Page

A.3.2 PageHeader and PageFooter sections

The PageHeader and PageFooter elements define report sections that are usu-
ally printed on every page of the report.

<!ELEMENT PageHeader (Line*, Label*, Special*)>
<!ATTLIST PageHeader

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

<!ELEMENT PageFooter (Line*, Label*, Special*)>
<!ATTLIST PageFooter

Height CDATA #REQUIRED
PrintFrequency CDATA #REQUIRED>

Attributes

Height Sets the height of the report section. If you don’t want this sec-
tion, set this value to 0.

PrintFrequency Set the print frequency of the section.

Value Print Frequency
0 First Page
1 Every Page
2 Last Page
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A.3.3 DetailHeader and DetailFooter sections

The DetailHeader and DetailFooter elements define report sections that are
printed before and after details of a given level and below on the report.

<!ELEMENT DetailHeader (Line*, Label*, Special*)>
<!ATTLIST DetailHeader

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

<!ELEMENT DetailFooter (Line*, Label*, Special*)>
<!ATTLIST DetailFooter

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

Attributes

Height Sets the height of the report section. If you don’t want this sec-
tion, set this value to 0.

Level Set the hierarchy level of the section. Sections with higher levels
will be printed before sections with lower ones. Level can be any
number beginning from 0.

A.3.4 Detail section

The Detail element defines the report section that contains the report data.
The report can have multiple details, which are accessed by the detail’s Level
attribute.

<!ELEMENT Detail (Line*, Label*, Special*, Field*)>
<!ATTLIST Detail

Height CDATA #REQUIRED
Level CDATA #REQUIRED>

Attributes

Height Sets the height of the report section. If you don’t want this sec-
tion, set this value to 0.

Level Set the hierarchy level of the section. Sections with higher levels
will be printed before sections with lower ones. Level can be any
number beginning from 0. This is an attribute of a row element in a
data file.
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A.3.5 Line

The Line element defines a report object used to draw lines on a report.

<!ELEMENT Line EMPTY>
<!ATTLIST Line

X1 CDATA #REQUIRED
Y1 CDATA #REQUIRED
X2 CDATA #REQUIRED
Y2 CDATA #REQUIRED
Width CDATA #REQUIRED
Color CDATA #REQUIRED
Style CDATA #REQUIRED>

Attributes

X1 Sets the starting x coordinate (relative to the section’s upper left cor-
ner) for the line.

Y1 Sets the starting y coordinate (relative to the section’s upper left cor-
ner) for the line.

X2 Sets the ending x coordinate (relative to the section’s upper left cor-
ner) for the line.

Y2 Sets the ending y coordinate (relative to the section’s upper left cor-
ner) for the line.

Width Sets the width of the line.
Color Sets the color of the line. The color is defined as an RGB (Red

Green Blue) value (r,g,b). r, g and b must be in the range 0..255.
Style Sets the drawing style for the line.

Value Line Style
0 No Pen
1 Solid
2 Dash
3 Dot
4 Dash Dot
5 Dash Dot Dot

A.3.6 Label

The Label element defines a report object used to draw fixed text on a report.

<!ELEMENT Label EMPTY>
<!ATTLIST Label

Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
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Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED>

Attributes

Text Sets the label’s text.
X Sets the x coordinate (relative to the section’s upper left corner) for

positioning the label.
Y Sets the y coordinate (relative to the section’s upper left corner) for

positioning the label.
Width Sets the width of the label.
Height Sets the height of the label.
BackgroundColor Sets the background color of the label. The color is

defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

ForegroundColor Sets the foreground color of the label. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

BorderColor Sets the border color of the label. The color is defined
as an RGB (Red Green Blue) value (r,g,b). r, g and b must be in the
range 0..255.

BorderWidth Sets the border width for the label.
BorderStyle Sets the border style for the label.

Value Border Style
0 None
1 Solid
2 Dash
3 Dot
4 Dash Dot
5 Dash Dot Dot

FontFamily Sets the font family for the label’s text.
FontSize Sets the font size for the label’s text.
FontWeight Sets the font weight for the label’s text.
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Value Font Weight
25 Light
50 Normal
63 Demi Bold
75 Bold
87 Black

FontItalic Sets the font italic flag for the label’s text.

Value Italic
0 False
1 True

HAlignment Sets the label’s horizontal text alignment.

Value Horizontal Alignment
0 Left
1 Center
2 Right

VAlignment Sets the label’s vertical text alignment.

Value Vertical Alignment
0 Top
1 Middle
2 Bottom

WordWrap Sets the word wrap flag for the label’s text.

Value Word Wrap
0 False
1 True

A.3.7 Field

The Field element defines a report object used to draw data on a report.

<!ELEMENT Field EMPTY>
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<!ATTLIST Field
Field CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DataType CDATA #REQUIRED
DateFormat CDATA #REQUIRED
Precision CDATA #REQUIRED
Currency CDATA #REQUIRED
NegValueColor CDATA #REQUIRED
CommaSeparator CDATA #REQUIRED>

Attributes

Field Sets the data field for the object. This is an attribute of a row ele-
ment in a data file.

Text Not used.
X Sets the x coordinate (relative to the section’s upper left corner) for

positioning the field.
Y Sets the y coordinate (relative to the section’s upper left corner) for

positioning the field.
Width Sets the width of the field.
Height Sets the height of the field.
BackgroundColor Sets the background color of the field. The color is

defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

ForegroundColor Sets the foreground color of the field. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

BorderColor Sets the border color of the field. The color is defined as an
RGB (Red Green Blue) value (r,g,b). r, g and b must be in the range
0..255.

BorderWidth Sets the border width for the field.
BorderStyle Sets the border style for the field.
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Value Border Style
0 None
1 Solid
2 Dash
3 Dot
4 Dash Dot
5 Dash Dot Dot

FontFamily Sets the font family for the field’s text.
FontSize Sets the font size for the field’s text.
FontWeight Sets the font weight for the field’s text.

Value Font Weight
25 Light
50 Normal
63 Demi Bold
75 Bold
87 Black

FontItalic Sets the font italic flag for the field’s text.

Value Italic
0 False
1 True

HAlignment Sets the field’s horizontal text alignment.

Value Horizontal Alignment
0 Left
1 Center
2 Right

VAlignment Sets the field’s vertical text alignment

Value Vertical Alignment
0 Top
1 Middle
2 Bottom
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WordWrap Sets the word wrap flag for the field’s text.

Value Word Wrap
0 False
1 True

DataType Sets the field’s data type.

Value Data Type
0 String
1 Integer
2 Float
3 Date
4 Currency

DateFormat Sets the field’s date format. For this to work, the format
of the date from the data document must be in the format mm/d-
d/yyyy or mm-dd-yyyy, otherwise the original date format is used.
If the data type is other than date, set this to 0.

Value Date Format
0 m/d/yy
1 m-d-yy
2 mm/dd/yy
3 mm-dd-yy
4 m/d/yyyy
5 m-d-yyyy
6 mm/dd/yyyy
7 mm-dd-yyyy
8 yyyy/m/d
9 yyyy-m-d
10 dd.mm.yy
11 dd.mm.yyyy

Precision Sets the field’s numeric precision. If the data type is other than
a numeric type, set this to 0.

Currency Sets the field’s currency symbol If the data type is other than
currency, set this to 36 ($). The value is a number representing a
Unicode character.

NegValueColor Sets the color for negative numeric values. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must
be in the range 0..255. If data is other than a numeric type, set to
255,0,0.
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CommaSeparator Sets whether commas are used in numeric fields. If
the data type is other than a numeric type, set this to 0.

Value Comma Separator
0 False
1 True

A.3.8 CalculatedField

The CalculatedField element defines a report object used to draw calculated
values on a report.

<!ELEMENT CalculatedField EMPTY>
<!ATTLIST CalculatedField

CalculationType CDATA #REQUIRED
Field CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DataType CDATA #REQUIRED
DateFormat CDATA #REQUIRED
Precision CDATA #REQUIRED
Currency CDATA #REQUIRED
NegValueColor CDATA #REQUIRED
CommaSeparator CDATA #REQUIRED>

Attributes

CalculationType Sets the calculation type for the field.

Value Calculation
0 Count
1 Sum
2 Average
3 Variance
4 Std Deviation

39



The Kugar Handbook

Field Sets the data field for the object. This is an attribute of a row ele-
ment in a data file.

Text Not used.
X Sets the x coordinate (relative to the section’s upper left corner) for

positioning the field.
Y Sets the y coordinate (relative to the section’s upper left corner) for

positioning the field.
Width Sets the width of the field.
Height Sets the height of the field.
BackgroundColor Sets the background color of the field. The color is

defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

ForegroundColor Sets the foreground color of the field. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

BorderColor Sets the border color of the field. The color is defined as an
RGB (Red Green Blue) value (r,g,b). r, g and b must be in the range
0..255.

BorderWidth Sets the border width for the field.
BorderStyle Sets the border style for the field.

Value Border Style
0 None
1 Solid
2 Dash
3 Dot
4 Dash Dot
5 Dash Dot Dot

FontFamily Sets the font family for the field’s text.
FontSize Sets the font size for the field’s text.
FontWeight Sets the font weight for the field’s text.

Value Font Weight
25 Light
50 Normal
63 Demi Bold
75 Bold
87 Black

FontItalic Sets the font italic flag for the field’s text.
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Value Italic
0 False
1 True

HAlignment Sets the field’s horizontal text alignment.

Value Horizontal Alignment
0 Left
1 Center
2 Right

VAlignment Sets the field’s vertical text alignment.

Value Vertical Alignment
0 Top
1 Middle
2 Bottom

WordWrap Sets the word wrap flag for the field’s text.

Value Word Wrap
0 False
1 True

DataType Sets the field’s data type.

Value Data Type
0 String
1 Integer
2 Float
3 Date
4 Currency

DateFormat Sets the field’s date format. For this to work, the format
of the date from the data document must be in the format mm/d-
d/yyyy or mm-dd-yyyy, otherwise the original date format is used.
If the data type is other than date, set this to 0.
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Value Date Format
0 m/d/yy
1 m-d-yy
2 mm/dd/yy
3 mm-dd-yy
4 m/d/yyyy
5 m-d-yyyy
6 mm/dd/yyyy
7 mm-dd-yyyy
8 yyyy/m/d
9 yyyy-m-d
10 dd.mm.yy
11 dd.mm.yyyy

Precision Sets the field’s numeric precision. If the data type is other than
a numeric type, set this to 0.

Currency Sets the field’s currency symbol. If the data type is other than
currency, set this to 36 ($). The value is a number representing an
unicode character.

NegValueColor Sets the color for negative numeric values. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must
be in the range 0..255. If data is other than a numeric type, set to
255,0,0.

CommaSeparator Sets whether commas are used in numeric fields. If
the data type is other than a numeric type, set this to 0.

Value Comma Separator
0 False
1 True

A.3.9 Special

The Special element defines a report object used to draw page numbers and
the current date on a report.

<!ELEMENT Special EMPTY>
<!ATTLIST Special

Type CDATA #REQUIRED
Text CDATA #REQUIRED
X CDATA #REQUIRED
Y CDATA #REQUIRED
Width CDATA #REQUIRED
Height CDATA #REQUIRED
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BackgroundColor CDATA #REQUIRED
ForegroundColor CDATA #REQUIRED
BorderColor CDATA #REQUIRED
BorderWidth CDATA #REQUIRED
BorderStyle CDATA #REQUIRED
FontFamily CDATA #REQUIRED
FontSize CDATA #REQUIRED
FontWeight CDATA #REQUIRED
FontItalic CDATA #REQUIRED
HAlignment CDATA #REQUIRED
VAlignment CDATA #REQUIRED
WordWrap CDATA #REQUIRED
DateFormat CDATA #REQUIRED>

Attributes

Type Sets the type of special object.

Value Type
0 Current Date
1 Page Number

Text Not used.
X Sets the x coordinate (relative to the section’s upper left corner) for

positioning the field.
Y Sets the y coordinate (relative to the section’s upper left corner) for

positioning the field.
Width Sets the width of the field.
Height Sets the height of the field.
BackgroundColor Sets the background color of the field. The color is

defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

ForegroundColor Sets the foreground color of the field. The color is
defined as an RGB (Red Green Blue) value (r,g,b). r, g and b must be
in the range 0..255.

BorderColor Sets the border color of the field. The color is defined as an
RGB (Red Green Blue) value (r,g,b). r, g and b must be in the range
0..255.

BorderWidth Sets the border width for the field.
BorderStyle Sets the border style for the field.

Value Border Style
0 None
1 Solid
2 Dash
3 Dot
4 Dash Dot
5 Dash Dot Dot
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FontFamily Sets the font family for the field’s text.
FontSize Sets the font size for the field’s text.
FontWeight Sets the font weight for the field’s text.

Value Font Weight
25 Light
50 Normal
63 Demi Bold
75 Bold
87 Black

FontItalic Sets the font italic flag for the field’s text.

Value Italic
0 False
1 True

HAlignment Sets the field’s horizontal text alignment.

Value Horizontal Alignment
0 Left
1 Center
2 Right

VAlignment Sets the field’s vertical text alignment.

Value Vertical Alignment
0 Top
1 Middle
2 Bottom

WordWrap Sets the word wrap flag for the field’s text.

Value Word Wrap
0 False
1 True
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DateFormat Sets the field’s date format. For this to work, the format
of the date from the data document must be in the format mm/d-
d/yyyy or mm-dd-yyyy, otherwise the original date format is used.
If the data type is other than date, set this to 0.

Value Date Format
0 m/d/yy
1 m-d-yy
2 mm/dd/yy
3 mm-dd-yy
4 m/d/yyyy
5 m-d-yyyy
6 mm/dd/yyyy
7 mm-dd-yyyy
8 yyyy/m/d
9 yyyy-m-d
10 dd.mm.yy
11 dd.mm.yyyy

Precision Sets the field’s numeric precision. If the data type is other than
a numeric type, set this to 0.

A.4 KugarData Document Type Definition

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE KugarData [

<!ELEMENT KugarData (Row*)>
<!ATTLIST KugarData

Template CDATA #REQUIRED>
<!ELEMENT Row EMPTY>
<!ATTLIST Row

level CDATA #REQUIRED
col1 CDATA #IMPLIED
col2 CDATA #IMPLIED
... CDATA #IMPLIED
coln CDATA #IMPLIED>

]>

A.5 KugarData element

The KugarData element defines a report’s data source. The basic structure is a
collection of rows and columns. This document does not define data types and
their attributes. The report template defines column data type information.

The document creator can apply an XSL style sheet to an existing document to
convert it to this format. If XSL is used, the creator can apply custom macros
using XSL for column calculations, sorting, etc..
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<!ELEMENT KugarData (Row*)>
<!ATTLIST KugarData

Template CDATA #REQUIRED>
<!ELEMENT Row EMPTY>
<!ATTLIST Row

level CDATA #REQUIRED
col1 CDATA #IMPLIED
col2 CDATA #IMPLIED
... CDATA #IMPLIED
coln CDATA #IMPLIED>

A.5.1 Kugar data element

The KugarData element contains zero or more Row elements. A Row must con-
tain one level attribute with a value corresponding to detail level in the tem-
plate. Other attributes represent data columns.

The value of the Template attribute is the URL of the report template used to
format the data.

A.5.2 Row element

Attributes

level The attribute value indicates which detail in the report template
is used to display data. Rows can contain various column sets for
various levels, so any attribute except level should be stated as #IM-
PLIED.

column The name of the attribute is the column name, and uses the for-
mat as given in the KugarData definition. The attribute name is used
in the report template to bind the data to the report fields.
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Appendix B

Installation

Kugar is part of the KDE project http://www.kde.org/ .

Kugar can be found in the koffice package on ftp://ftp.kde.org/pub/kde/ ,
the main FTP site of the KDE project.

In order to compile and install Kugar on your system, type the following in the
base directory of the Kugar distribution:

% ./configure
% make
% make install

Since Kugar uses autoconf and automake you should have no trouble compil-
ing it. Should you run into problems please report them to the KDE mailing
lists.
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